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Instructions for using 

this Template 
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Continuing Articles 

Across Pages. 
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Using Columns 
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Formatting Text Boxes 
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Inserting and Editing 

Pictures 

4 
Questions and Answers 

 
 

 
 

 
 

 
 

Company Name 

Number Street Address 

City, State  Postal Code 

Country 

 

From the Director 
Velma C. Navarro 

 

To keep these instructions, choose 

Print from the File menu. Press 

Enter to print the template. Replace 

the sample text with your own text to 

create a newsletter. 

Using Styles in this Template  

To change the style of any 

paragraph, select the text by 

positioning your cursor anywhere in 

the paragraph. Select a Style from 

the drop-down Style list at the top-

left of your screen. Press Enter to 

accept your choice. 

The styles available in this template 

allow you to change the look of your 

headlines and other text. The 

following is a list of some common 

styles and their uses. 

Body Text – Use this style for the 

regular text of your articles. 

Byline – Use this style for the name 

of an article’s author. 

Calendar Head – Use this style to 

type a second level heading in a 

sidebar article. 

Calendar Subhead – Use this style 

to type a third level heading in a 

sidebar article. 

 

 type first-level headings in a sidebar 

article. 

Footer – Use this style to type 

repeating text at the bottom of each 

page. 

Heading1 – Use this style to create 

headlines for each article. 

Heading2 – Use this style to create 

section headings in an article. 

Jump To and Jump From – Use 

these styles to indicate that an 

article continues on another page.  

Using Columns 

  

. 

Office of Public Housing 

    ~ San Francisco 

Continuing Articles 

across Pages 

Your By-line 

Some of the articles in this newsletter 

were created using linked text boxes, 

which allow articles to flow 

continuously across pages. When you 

add lines of words to a text box, the 

words in the following text box flow 

forward. When you delete words from a 

text box, the words in the next text box 

move back. You can link several text 

boxes in an article and you can have 

multiple articles in a document. The 

links do not have to occur in a forward 

direction. 

To insert linked text boxes in a 

document, click Text Box on the Insert 

menu. Click and drag in your document 

where you want to insert the first text 

box. Insert additional text boxes where 

you want the text to flow. 

To select the first text box, move the 

Continued on Page 3 
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CALENDAR OF DUE DATES 
(http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/post/calendar) 

 
This web page, Calendar of Due Dates, lists Public Indian Housing (PIH) requirements for  
 
 

 PHAs with fixed due dates:  
(http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/post/calendar) 

 
 

 PHAs with varying due dates can be found here:  
( http://portal.hud.gov/huddoc/post-more-pih-req.pdf) 

 
 

TRUST but VERIFY:   PHAs must comply with all applicable HUD requirements, regardless of the content of this Calendar.    

DUE DATES FOR 2012 

Date Description HCV PH Grants ONAP 

OCTOBER   

4 VMS Reporting Opens  X       

9 CY2013 Operating Fund Forms    X     

10 Minority Business Development Contract and Subcontract Activity  X X X   

18 Indian Housing Plan (12/31 FYE)          

18 5-Year PHA Plan (12/31 FYE)  X X     

18 Annual PHA Plan (12/31 Non-Qualified PHAs) X X     

18 Capital Fund Program P & E Report (12/31 FYE)    X     

18 
Capital Fund Program Annual Statement (12/31 Non-Qualified PHAs 
First-Time Submission)  

  X     

18 Civ Rights Cert (12/31 Qual. PHAs)  X X     

22 VMS Submissions  X       

30 Federal Financial Report for IHBG          

30 Enterprise Income Verification (EIV) Employee Recertification     X     

31 
Semi-Annual Labor Standards Enforcement Report-Local 
Contracting Agencies  

X X X   

31 EPIC Quarterly Reporting   X     

NOVEMBER    

4 VMS Reporting Opens  X       

15 Unaudited Extension Request (9/30 FYE)  X X     

22 VMS Submissions  X       

29 SEMAP Certification (9/30 FYE)  X       

30 Unaudited Due Date (9/30 FYE)  X X     

DECEMBER   

1 Waiver of Due Date for Audited Financial Info. (3/31 FYE)  X X     

4 VMS Reporting Opens  X       

22 VMS Submissions  X       

29 IHBG Funds Annual Performance Report (9/30 FYE)          

31 Audited Due Date (3/31 FYE)  X X     

31 Submit Board Resolutions Approving Operating Budget (12/31 FYE)    X     

31 Notif. of Turnover of FUP Vouchers  X       

31 FYE Change Request Due (3/31 FYE)  X X     

 

http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/post/calendar
http://portal.hud.gov/huddoc/post-more-pih-req.pdf
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://portal.hud.gov/huddoc/2013submissionschedule.pdf
http://www.hud.gov/offices/adm/hudclips/forms/files/2516.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=pih2011-23.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec903-5.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec903-5.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=pih2011-24.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=pih2011-24.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=pih2011-24.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec903-5.pdf
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=PIH-2011-21LOCCS.docx
http://portal.hud.gov/hudportal/documents/huddoc?id=11-25pihn.doc
http://www.gpo.gov/fdsys/pkg/CFR-2011-title29-vol1/pdf/CFR-2011-title29-vol1-sec5-7.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title29-vol1/pdf/CFR-2011-title29-vol1-sec5-7.pdf
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/epic
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec902-60.pdf
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec985-101.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec902-33.pdf
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec902-60.pdf
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://portal.hud.gov/huddoc/pih2012-21.pdf
http://portal.hud.gov/hudportal/documents/huddoc?id=PIH-2011-21LOCCS.docx
http://www.gpo.gov/fdsys/pkg/CFR-2011-title24-vol4/pdf/CFR-2011-title24-vol4-sec902-33.pdf
http://portal.hud.gov/huddoc/11-55pihn.doc
http://portal.hud.gov/hudportal/documents/huddoc?id=11-52pihn.doc
http://portal.hud.gov/huddoc/11-57pihn.doc
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U.S. Department Of Housing & Urban Development 
 

San Francisco Office of Public Housing 
 

    News Staff 
 

      Director            Velma.C.Navarro@hud.gov 

      Division Director  Melina.M.Whitehead@hud.gov 

      Division Director  Gerard.Windt@hud.gov 

      Capital Funds          Norma.L.Penamante@hud.gov 

     IPA Audits           Claire.A.Garcia@hud.gov 

      PIC            Richard.T.Kim@hud.gov 

      Public Housing Andrew.Nguyen@hud.gov            

     Section 8           Martha.E.Ruiz@hud.gov  

     Editor Carroll.J.Lorbett@hud.gov 

 

Subscriptions:  The San Francisco Office of Public Housing’s newsletter is 

published on a quarterly basis and distributed free of charge.  To receive the news 

by e-mail send your e-mail address to Carroll.J.Lorbett@hud.gov or visit HUD’s 

website. 

 

Disclaimer:  This publication provides general coverage of its subject areas.  It is 

distributed with the understanding that the publisher is not engaged in rendering 

legal, accounting, or other professional advice or services.  If legal advice or other 

expert assistance is required, the services of a competent professional should be 

sought.  The publisher shall not be responsible for any damages resulting from any 

error, inaccuracy, or omission contained in this publication. 

 

~ # ~ 

 

During National Disability Employment 
Awareness Month (DEAM), we 
recognize the indispensable 
contributions people with disabilities 
make in our country, as well as, 
celebrate the many and varied 
contributions of America's workers with 
disabilities. 

DEAM's roots go back to 1945, when 
Congress enacted a law declaring the 
first week in October each year 
"National Employ the Physically 
Handicapped Week." In 1962, the word 
"physically" was removed to 
acknowledge the employment needs 
and contributions of individuals with all 
types of disabilities. In 1988, Congress 
expanded the week to a month and 
changed the name to "National 
Disability Employment Awareness 
Month.  

 
(Information courtesy of the Department of 

Labor, Office of Disability Employment 

Policy) 

 

 

HUD’s e-newsletters are an excellent to tool to keep informed. 
 

Asset Management e-Newsletter 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/am/newsletter 
 

Public Housing Energy Conservation Clearinghouse (PHECC) 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/phecc/newsletter/newsletter 
 

Housing Choice Voucher E-Newsletter - HUD 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/newsletter 
 

 The Resident Newsletter 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/newsletter 

  

 

 

mailto:Velma.C.Navarro@hud.gov
mailto:Melina.M.Whitehead@hud.gov
mailto:Gerard.Windt@hud.gov
mailto:Norma.L.Penamante@hud.gov
mailto:Claire.A.Garcia@hud.gov
mailto:Richard.T.Kim@hud.gov
mailto:Andrew.Nguyen@hud.gov
mailto:Martha.E.Ruiz@hud.gov
mailto:Carroll.J.Lorbett@hud.gov
mailto:Carroll.J.Lorbett@hud.gov
http://www.hud.gov/local/ca/working/ph/news.cfm
http://www.hud.gov/local/ca/working/ph/news.cfm
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/am/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/am/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/phecc/newsletter/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/phecc/newsletter/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/newsletter
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/newsletter
http://www.google.com/imgres?imgurl=http://us.cdn3.123rf.com/168nwm/littlepaw/littlepaw1210/littlepaw121000020/15637917-funny-owl-reading-a-book.jpg&imgrefurl=http://www.123rf.com/clipart-vector/reading_glasses.html&usg=__20L0ZVfYOKlgyH4wTeZ5M9iaF9c=&h=168&w=168&sz=7&hl=en&start=106&zoom=1&tbnid=f3SgxuSn9CrOPM:&tbnh=99&tbnw=99&ei=GQaIUOLnIKvh0wHc8YGgCQ&prev=/search%3Fq%3Dfree%2Bclip%2Bart%2Bowl%2Bwith%2Bglasses%26start%3D100%26hl%3Den%26sa%3DN%26gbv%3D2%26tbm%3Disch&itbs=1
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OFFICE OF CAPITAL IMPROVEMENTS 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund 

  
(NEW) Highlights from the HUD webpage: 

  

  

 (NEW) PIH 2012-41(HA): Processing Information for the Submission of Replacement Housing Factor 

(RHF) Plans - This Notice applies to public housing agencies (PHAs) who are currently receiving or expect to 

receive Replacement Housing Factor (RHF) grants (also referred to in this Notice as “RHF funds,” especially when 

referring to more than one year of RHF funding).  

  

 (NEW) Proposal to Consolidate the Capital and Operating Funds  

 (NEW) Operating Fund Financing Program Web Guidance  

 (NEW) Reporting Requirement to Collect Energy Efficiency Measures  

 (NEW) FY 2012 Capital Fund Award letter to the PHA Executive Director  

 (NEW) FY 2012 Capital Fund Processing Timeline  

 (NEW) 2012 map with the Capital Fund grant amounts and Annual Contributions Contract(s) (ACC)   

  

 (NEW) “Faircloth Limit” Unit Counts - Section 9(g) (3) of the United States Housing Act of 1937("Faircloth 

Amendment") limits the construction of new public housing units.  The Faircloth Amendment states that the 

Department cannot fund the construction or operation of new public housing units with Capital or Operating Funds if 

the construction of those units would result in a net increase in the number of units the PHA owned, assisted or 

operated as of October 1, 1999.  This requirement is referred to as the “Faircloth Limit.”  PHAs should review the 

linked (NEW) National List of Maximum Number of Units Eligible for Capital Funding and Operating Subsidy 

by PHA (PDF). If you do not believe that the number of units listed for your PHA is correct, please send an email to 

PIH_OCI @hud.gov with “Faircloth Limit Correction for…” and your PHA code in the subject line.  

  

 (NEW) HOPE VI Replacement Unit Counts - The Department is making preparations for calculating the Capital 

Fund formula for FFY 2012. For PHAs that have HOPE VI Revitalization grants the number of public housing units 

that a PHA is planning to replace as part of its HOPE VI grant affects the number of removed units that are eligible 

for Replacement Housing Factor (RHF) funds. PHAs can validate whether the count is correct by reviewing the 

linked HOPE VI replacement unit counts spreadsheet (MS-Excel). Please note this is the planned number of 

ACC units to be replaced not the actual units replaced to date.  

 If a PHA believes there is an error in the list, it must submit an e-mail explaining the error to PIHOCI@hud.gov and 

Sue Wilson at Susan.Wilson@hud.gov  no later than December 14th, 2011.  

  

 (NEW) PHAS High Performer list for 2012 Capital Fund Calculation: The Department is making 

preparations for calculating the Capital Fund formula for 2012. As a part of the calculation the Department is using 

PHAS designations for Federal Fiscal Year 2010 to determine which PHAs will receive the high performer bonus for 

the 2012 formula calculation. (Note: for PHAs with fiscal year ends of 12/31/09 the 2009 PHAS score is used; for 

PHAs with fiscal year ends of 3/31/10, 6/30/10 and 9/30/10 the 2010 PHAS score is used). PHAs can validate 

whether they are on the High Performer list that will be the basis for the formula calculation by reviewing the linked 

High Performer List for 2012 Capital Fund Calculation spreadsheet (MS-Excel). The spreadsheet lists only 

PHAs that are designated as high performers in Federal Fiscal Year 2010 (it lists the Housing Authority Code, the 

Housing Authority Name and the City/State of the housing authority). 

  

(NEW) 2012 Unit Total Development Cost (TDC) Limits  

 

 

http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund
http://portal.hud.gov/huddoc/pih2012-41.pdf
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/phfundconsolidation
http://portal.hud.gov/huddoc/opfund-financing-guide.pdf
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/epic
http://portal.hud.gov/huddoc/cf-2012-edletter.pdf
http://portal.hud.gov/huddoc/cf-2012-timeline.pdf
http://www.hud.gov/offices/pih/programs/ph/capfund/grants/2012/
http://portal.hud.gov/huddoc/natllistunits.pdf
http://portal.hud.gov/huddoc/natllistunits.pdf
mailto:PIH_OCI%20@hud.gov
http://portal.hud.gov/huddoc/2012hope6list.xlsx
mailto:PIHOCI@hud.gov
mailto:Susan.Wilson@hud.gov
http://portal.hud.gov/huddoc/high_performer_list.xls
http://portal.hud.gov/huddoc/2012TDCReport.pdf
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The Energy Performance Information Center (EPIC) 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/epic 

What is EPIC? 

The Energy and Performance Information Center (EPIC) is a program designed to collect summary capital 
fund grant activity and energy efficiency measures (EEM) – planned and completed - being implemented 
with PIH Capital Fund Formula or RHF grants.  It is similar in appearance and functionality to the RAMPS 
program which was used to collect EEM for ARRA grants.  
 
Starting April 2, 2012,   PHAs are required to report their activities in EPIC on a quarterly basis after the 
conclusion of each quarter.  PHAs must submit a report for all open Formula and RHF grants. 

Reporting in EPIC 

The initial reporting period lasted six weeks, and all subsequent reporting periods will last only for four 
weeks.  PHAs will have from April 1, 2012 through May 18, 2012 to complete their initial reports.  Thereafter 
reporting will occur on a quarterly basis according to the chart below and reports for each quarter must be 
completed by the last day of the Reporting Period. 

Calendar Year Quarter Federal Fiscal Year Reporting Period 

1 2 April 1 - April 30 

2 3 July 1 - July 31 

3 4 October 1 - October 31 

4 1 January 1 - January 31 

IMPORTANT:  EPIC is collecting summary capital fund grant activity and EEM activity - planned and 
completed- after the beginning of Federal Fiscal Year 2012.  Therefore, any EEM work completed prior to 
October 1, 2011 should not be reported on in EPIC.Accessing EPIC 

EPIC can be found at: http://portal.hud.gov/app_epic.  Please add this to your Favorites in your web 
browser for easy future access. 

 
 
National Energy Action Month promotes smart energy choices and highlights 

supporting our economy, protecting our environment and increasing energy independence.  
 
No matter how large the problem may appear, the fact remains that each of us is a part of the solution. Every 
day, each of us makes decisions that can stimulate sustainability, and a new energy economy. When we put 
all the pieces together, all of us; the federal government, private industry, and the public, have the means to 
shape our energy future and move our nation toward energy independence. 

For more information on National Energy Action Month and to view the President’s proclamation signed on 
October 1, 2012, please visit: (http://www.whitehouse.gov/the-press-office/2012/10/01/presidential-proclamation-national-energy-action-

month-2012)  

 

 

 

ENERGY 

http://portal.hud.gov/app_epic
http://portal.hud.gov/app_epic
http://www.whitehouse.gov/blog/2012/10/04/national-energy-action-month
http://www.whitehouse.gov/the-press-office/2012/10/01/presidential-proclamation-national-energy-action-month-2012
http://www.whitehouse.gov/the-press-office/2012/10/01/presidential-proclamation-national-energy-action-month-2012
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PHYSICAL NEEDS ASSESSMENT OF PUBLIC HOUSING 
(http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/physicalassessment) 

 
There has been an increasing focus within HUD 

and the housing industry generally, on energy 
conservation and green asset management.  

The Office of Public and Indian Housing (PIH) is 
developing a Physical Needs Assessment (PNA) 
process to achieve a number of critical goals in the 
management of public housing and HUD’s 
oversight of Public Housing Authorities (PHAs). 

The primary objectives of the new PNA process will 
be to: 

1. enable HUD to measure the impact of 
annual Capital Fund appropriations on the 
physical needs of the public housing 
inventory  

 
2. enable PHAs to better assess the capital 

needs of their portfolios, to facilitate capital 
planning and to allow PHAs to take 
advantage of capital improvement 
opportunities  

 
3. evolve the management practices of PHAs 

toward development-based capital planning  
 

4. further the energy integration goals of the 
2005 Energy Policy Act  

 
5. produce data on green activities for the 

Capital Fund, in support of HUD’s 
Performance Goal to create energy efficient 
housing  

Capital Funds averaging more than $2 billion 
annually are provided to PHAs to modernize or 
develop public housing.  Currently, HUD has no 
process in place to assess and measure the impact 
of these funds on the public housing portfolio.  The 
PNA process will allow this estimate to be updated 
on a continuous annual basis to reflect the trends of 
needs addressed with Capital Funds or other 
sources. The PNA will be performed every 5 years 
by PHAs. 

At the same time, existing PNA requirements for 
PHAs are outdated and do not reflect the realities of 

capital planning in the housing industry generally.  
HUD has developed a PNA tool for use by PHAs for 
long term project based strategic planning. The new 
PNA tool will allow PHAs to assess the needs of 
their public housing portfolio over a planning 
horizon of 20 years, will produce useful reporting, 
and will automatically create HUD reporting. The 
PNA will enable PHAs to move more nimbly to take 
advantage of new opportunities as capital markets 
change and new programs and funding sources 
become available. 

The PNA tool, the PNA process includes two new 
rules which serve to implement the PNA 
requirement and set out the basic outline and 
protocols of the process.  The PNA Rule will 
require all 3000+ PHAs nationwide to complete a 
comprehensive PNA for each of their public 
housing developments once every five years and to 
update these assessments annually. A new Energy 
Audit Rule will establish standards for public 
housing energy audits, integrating energy 
conservation measures with capital planning in a 
holistic planning approach.  As of July, 2012 the 
rules are both in the final rulemaking process and 
are expected to be published as final rules in the 
fall of 2012 for immediate implementation by PHAs 
over the ensuing one year period with due dates 
based upon fiscal year end dates. 

The Green Physical Needs Assessment (GPNA) 
tool has been developed and pilot tested by HUD at 
9 PHAs ranging in size from 80 to 5400 units 
representing a total of 11,000 public housing units. 
In addition nearly 20 PHAs have voluntarily 
participated in beta testing of the tool and provided 
comment on their experience with the tool. 

A final version of the GPNA tool (version 1.0 dated 
July 2, 2012) including a final draft users guide is 
available to PHAs to begin using in advance of the 
final rules. In addition we provide a working GPNA 
tool sample which has been populated with generic 
data so that users can begin to learn its functions 
and architecture. 

http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/physicalassessment
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/ph/capfund/physicalassessment
http://portal.hud.gov/huddoc/frpublicationpnarule.pdf
http://portal.hud.gov/huddoc/energyauditrule.pdf
http://portal.hud.gov/huddoc/energyauditrule.pdf
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insertion point to the top of the next 
column. 

Balancing Column Length 

If your text is not already formatted 

in columns, create the columns. In 

page layout view, click at the end of 

the columns you want to balance. 

On the Insert menu, click Break. 

Click Continuous. Word inserts a 

continuous section break, which 

balances the text equally among the 

columns. 

If you want to force a new page to 

start after the balanced columns, 

click after the continuous section  

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text.  

This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. 

This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text.  

This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. 

Inserting and 
Editing Pictures 
Your By-line 

You can replace the pictures in this 

template with your company's art. 

Select the picture you want to 

replace, point to Picture in the Insert 

menu, and click From File. Choose 

a new picture and then click Insert. 

Select the Link to File box if you 

don’t want to embed the art in the 

newsletter. This is a good idea if you 

need to minimize your file size. 

Embedding a picture adds 

significantly to the size of the file. 

You might want to consider 

embedding a picture if file size is not 

an issue and you use a picture in 

every edition of your newsletter. 

To edit a picture, click on it to 

activate the Picture toolbar. You can 

use this toolbar to adjust brightness 

and contrast, change line properties 

and crop the image. 

You can also use the Format Picture 

dialog box to edit a picture. To open 

it, select the picture, click the right 

mouse button, and click Format 

Picture. You can change the size 

and position of the picture, crop it, 

adjust the brightness and contrast, 

and change the text wrapping. The 

pictures in this template use the tight 

wrapping style. 

For more detailed editing, double-

click on the graphic to activate the 

drawing layer, where you can group  

  

Date, Time 

Location 

Event name 

Type a description of your event 

here. For more information call 

000-0000. 

Date, Time 

Location 

Event name 

Type a description of your event 

here. For more information call 

000-0000. 

Date 

Time, Location 

Event name 

Type a description of your event 

here. For more information call 

000-0000. 
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or ungroup picture objects, re-color, 

or delete objects. 

This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text. This is placeholder 

text. This is placeholder text. This is 

placeholder text.  

 

Questions and Answers 

Q:   I would like to change some of 

the text box shading to improve the 

print quality. Can that be done? 

A:   Yes. To change the shading or 

color of a text box, select it and 

double click its borders to open the 

Format Text Box dialog box. Click the 

Colors and Lines tab and then 

choose the new color from the Color 

drop-down list in the Fill section. 

Q:   What’s the best way to print this 

newsletter? 

A:   Print page 2 on the back of page 

1. Fold in half and mail with or without 

an envelope. For best results, use a 

medium to heavyweight paper. If 

you’re mailing without an envelope, 

seal with a label. 

Q:   I would like to use my own clip 

art. How do I change the art without 

changing the design? 

A:   To change a picture, click on the 

picture, then point to Picture on the 

Insert menu and click From File. 

Choose a new picture, and click 

Insert.   

Q:   How do I change the text and 

borders that appear at the bottom of 

every page? 

A:   Click Headers and Footers on the 

View menu. Use the Header and 

Footer toolbar to navigate among 

headers and footers, insert date or 

time, or format the page numbers. To 

change the text in the footer, select it 

and type your new text. To change 

the border, click Borders and Shading 

on the Format menu. 

Q:   Can I save a customized 

newsletter as a template for future 

editions? 

A:   Yes. Type your own information 

over the sample text and then click 

Save As on the File menu. Choose 

Document Template from the Save 

as type drop down list (the extension 

should change from .doc to .dot). 

Save the file under a new name. Next 

time you want to create a newsletter, 

click New on the File menu, then 

choose your template. 
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Office of Housing Choice Vouchers 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv 
 
What’s new? 

Webcasts 

 (NEW) Cash Management Update Broadcast - October 10, 2012 (MS-PowerPoint)  

 (NEW) CY 2012 HCVP Implementation Broadcast (MS-PowerPoint)  

 (NEW) FY 2012 HCV FSS NOFA Slides (MS-PowerPoint)  

 (NEW) FY 2012 Housing Choice Voucher/ Family Self-Sufficiency NOFA Webcast: Tuesday, March 6, 

2012, 11:00 a.m. Eastern Standard Time  

 HCVP 2011 Appropriations Implementation – Broadcast Slides (MS-PowerPoint)  

Program Related Information 

 (NEW) Housing Credit Agencies - PBV Subsidy Layering Reviews  

 (NEW) Housing Choice Voucher Program - CY 2012 Administrative Fee Rates  

o CY 2012 Administrative Fee Rates Description (MS-Word)  
o CY 2012 Administrative Fee Rate Tables (MS-Excel) 

  (NEW) Non-Elderly Disabled (NED) webpage  

 Family Unification Program (FUP) webpage  

 (NEW) HCV 2 year Forecasting Tool: HUD has developed a spreadsheet tool for use by PHA and HUD 

staff to assist in projecting HCV leasing, spending and funding over a two year period. The purpose is to 
facilitate decision making by PHAs and to guide HUD oversight and technical assistance so that PHAs can 
achieve optimal use of the HCV funds while stabilizing the program. The goal is to make full use of the 
program while avoiding the typical large cyclical swings of lease up followed by attrition, and to eliminate 
abrupt cutbacks that might adversely impact participants. If you have any questions, contact your local 
HUD office of Public Housing.  

o Forecast User Guidance  

o Forecasting Tool (MS-Excel) - This version Forecasting Tool v2.1 (AKA V8.7 in guidance 
document) corrects a year two formula effecting monthly spending percentages in the case of the 
user testing a scenario of an NRA offset. Please disregard prior versions. 

Family Unification Program (FUP) 

http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/family 

 
 

Public Housing Assessment System (PHAS) 
 
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/reac/products/prodphas 

 NEW) PHAS Capital Fund Interim Scoring Notice Revised June 2012: Pursuant to this Notice, all 

PHAs for fiscal years ending 3/31/2011, 6/30/2011, 9/30/2011, and 12/31/2011 will receive the full five 
points for the Capital Fund occupancy sub-indicator.  

 (NEW) HUD PHA Occupancy Percentage Calculations: This chart summarizes the HUD PHA occupancy 
percentage calculations under the PHAS Interim Rule for the Management Operations Indicator and the 

Capital Fund Program Indicator.  In addition, the chart also provides the Public Housing occupancy 
percentage calculation under HUD’s Agency Priority Goal Reporting.  

http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv
http://portal.hud.gov/huddoc/cashmgmtbroadcast.ppt
http://portal.hud.gov/huddoc/IMPLEMENTBRDCAST2-10-2012.ppt
http://portal.hud.gov/huddoc/fy12hcv-fssnofaslides.ppt
http://portal.hud.gov/hudportal/documents/huddoc?id=broadcast_fy2011.ppt
http://portal.hud.gov/hudportal/documents/huddoc?id=broadcast_fy2011.ppt
http://portal.hud.gov/hudportal/documents/huddoc?id=DOC_25725.xls
http://portal.hud.gov/huddoc/adminfee-narrative.doc
http://portal.hud.gov/huddoc/2012FEESRATES.xls
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/ned
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/family
http://portal.hud.gov/huddoc/FORECASTING_TOOL_v2.XLS
http://portal.hud.gov/huddoc/forecast_guidance.pdf
http://portal.hud.gov/huddoc/FORECASTING_TOOL_v2.XLS
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/programs/hcv/family
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/reac/products/prodphas
http://portal.hud.gov/hudportal/HUD?src=/program_offices/public_indian_housing/reac/products/prodphas
http://portal.hud.gov/huddoc/phasadvscoreinterimnotice.pdf
http://portal.hud.gov/huddoc/pha-occupancy-calc.pdf
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August through October 2012 Notices, Rules and Regulations 

Below is a list of PIH notices which provide guidance, extensions, instructions, clarifications, announcements and 
other policy information. The notices are also available on HUDclips. 

Note: HUD announces the end to hard copy mailing of PIH Notices. Notices will be available electronically only and 
posted on this website. 
 

Past PIH 
Notices: 

2011 > 2010 > 2009 > 2008 > 2007 > 2006 > 2005 > 2004 > 2003 > 2002 > 2001 > 
2000 > 1999 > 1998 > 1997 > 1996 > 1994-1995 

  

2012 Notices Issued/Expires Subject/Purpose 

PIH 2012-42 (HA) 
Issued: October 2, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Housing Choice Voucher Family Moves with Continued 
Assistance - This notice provides guidance on public housing 

agency (PHA) administrative responsibilities related to family 
moves with continued assistance both within a PHA’s 
jurisdiction and portability moves and restates Notice PIH 2011-
3, which has expired.  

PIH 2012-41 (HA) 
Issued: Sept. 28, 2012 
Expires: This notice remains in 

effect until amended, revoked 
or superseded 

Processing Information for the Submission of Replacement 
Housing Factor (RHF) Plans - This Notice applies to public 

housing agencies (PHAs) who are currently receiving or expect 
to receive Replacement Housing Factor (RHF) grants (also 
referred to in this Notice as “RHF funds,” especially when 
referring to more than one year of RHF funding). 

PIH 2012-40 (HA) 
Issued: Sept. 28, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Assisted Living Units in the Housing Choice Voucher (HCV) 
Program - This notice applies to all public housing agencies 

(PHA) that administer theHCV program for families that live in, 
or wish to live in, assisted living facilities.  

PIH 2012-39 
Issued: Sept. 10, 2012 
Expires: This notice remains in 

effect until amended, revoked 
or superseded 

Funding for Tenant-Protection Vouchers for Certain At-Risk 
Households in Low-Vacancy Areas – Request for 
Comments - This Noticeprovides instructions, eligibility, and 

selection criteria on the funding process for tenant protection 
vouchers for certain at-risk households in low-vacancy areas, as 
provided for in the “Consolidated and Further Continuing 
Appropriations Act, 2012” (PL 112-55), referred to hereafter as 
“the 2012 Appropriations Act,” enacted on November 18, 2011, 
and seeks public comment on these instructions and criteria.  

PIH 2012-38 (HA) 
Issued: Sept. 7, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Emergency Safety and Security Funding as it Relates to the 
Full-Year Continuing Appropriations Act, 2012 [Public Law 
112-36] - This Notice provides guidance to public housing 

agencies (PHAs) seeking Emergency Capital Needs funding for 
safety and security measures utilizing FY 2012 funds. 

PIH 2012-36 
Issued: August 27, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

SUPPLEMENTAL NOTICE to PIH Notice 2012-16 Request for 

Applications under the Moving to Work Demonstration 
Program for Fiscal Year 2011 - HUD issued PIH Notice 2012-
16 Request for Applications under the Moving to Work 
Demonstration Program for Fiscal Year 2011 on February 27, 

2012. Notice 2012-16 required prospective applicants to submit 
applications for the Moving to Work (MTW) Demonstration 
program by June 27, 2012.  

http://portal.hud.gov/portal/page/portal/HUD/program_offices/administration/hudclips/notices/pih
http://portal.hud.gov/hudportal/documents/huddoc?id=DOC_8119.pdf
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2011
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2010
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2009
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2008
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2007
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2006
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2005
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2004
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2003
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2002
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2001
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/2000
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/1999
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/1998
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/1997
http://portal.hud.gov/hudportal/HUD/program_offices/public_indian_housing/publications/notices/1996
http://www.hud.gov/hudclips/
http://portal.hud.gov/huddoc/pih2012-42.pdf
http://portal.hud.gov/huddoc/pih2012-41.pdf
http://portal.hud.gov/huddoc/pih2012-40.pdf
http://portal.hud.gov/huddoc/pih2012-39.pdf
http://portal.hud.gov/huddoc/pih2012-38.pdf
http://portal.hud.gov/huddoc/pih2012-36.pdf
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PIH 2012-35 (HA) 
Issued: August 21, 2012 
Expires: December 31, 2012 Federal Fiscal Year 2012 Funding Provisions for the 

Housing Choice Voucher Program – Award of Remaining 
Set-Aside Funds - This Notice announces the process that 

HUD will use to award the limited amount of funding remaining 
from the FFY 2012 Housing Assistance Payments (HAP) set-
aside (approximately $15 million) that was not awarded under 
the initial application process previously set forth in Notice PIH 
2012-9. 

PIH 2012-34 (HA) 
Issued: August 13, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Waiting List Administration - This notice provides guidance on 

the administration of a Public Housing Agency’s (PHA) Housing 
Choice Voucher (HCV) and Public Housing (PH) waiting lists, on 
the topics of opening the waiting list, applicant selection, placing 
applicants on the waiting list, and outreach. 

PIH 2012-33 (HA) 
Issued: August 8, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Extension of Notice PIH 2010-51 (HA), Over Subsidization in 
the Housing Choice Voucher Program - This Notice 

reinstates Notice PIH 2010-51, which expired on December 31, 
2011. 

PIH 2012-32 (HA) 

 Attachment 1 

Issued: July 26, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Rental Assistance Demonstration – Final Implementation - 

This notice (Notice) provides program instructions for the Rental 
Assistance Demonstration (RAD or Demonstration), including 
eligibility and selection criteria. 

PIH 2012-31 (HA) 
Issued: June 29, 2012 
Expires: This notice remains in 

effect until amended, 
superseded or rescinded 

Assisted housing for persons with disabilities under 
Olmstead implementation efforts to provide community-
based options rather than institutional settings - This 

guidance to public housing agencies (PHAs) describes actions 
PHAs may take to assist persons with disabilities transitioning 
from institutions and persons at serious risk of institutionalization 
access PHA-assisted housing.  

PIH 2012-30 
Issued: June 22, 2012 
Expires: Effective until 

amended, superseded, or 
rescinded 

Public Housing Operating Subsidy Eligibility Calculations 
for Calendar Year 2013 - This notice provides public housing 

agencies (PHAs) with instructions for the calculation of 
operating subsidy eligibility in Calendar Year (CY) 2013 in 
anticipation of Federal Fiscal Year (FFY) 2013 appropriations. 

PIH 2012-29 
Issued: June 21, 2012 
Expires: Effective until 

amended, superseded, or 
rescinded 

Establishing the Passbook Savings Rate - This Notice 

clarifies program policy related to the passbook savings rate 
used to determine annual income from net family assets. 

PIH 2012-28 
Issued: June 11, 2012 
Expires: Effective until 

amended, superseded, or 
rescinded 

State Registered Lifetime Sex Offenders in Federally 
Assisted Housing - This guidance reiterates owners’ and 

agents’ (O/As) and Public Housing Agencies’ (PHAs) statutory- 
and regulatory-based responsibilities to prohibit admission to 
individuals subject to a lifetime registration requirement under a 
State sex offender registration program. 

PIH 2012-27 (Updated) 

Related Attachments: 

 Attachment 1 

 Attachment 2 

 Attachment 3 

Issued: June 8, 2012 
Expires: December 31, 2012 

Calendar Year 2012 $20 Million Set-Aside for Financial 
Hardship due to Public Housing Operating Subsidy 
Allocation Adjustment  - This notice provides public housing 

agencies (PHAs) with information on the $20 million set-aside 
pursuant to HUD’s Federal Fiscal Year (FFY) 2012 
Appropriations, Public Law 112-55, to assist PHAs who 
encounter financial hardship as a direct result of the subsidy 
allocation adjustment applied to the Calendar Year (CY) 2012 
operating subsidy calculations (the “set-aside”). 

PIH 2012-26 (HA)  Issued: June 1, 2012 

Expires: May 31, 2013 

Extension: Administrative Guidance for Effective and 

Mandated Use of the Enterprise Income Verification 

(EIV) System - This notice extends notice PIH-2010-
19(HA), which was extended under notice PIH-2011-25, 
same subject, for another year until May 31, 2013. 

PIH 2012-25  Issued: May 29, 2012 
Expires: Effective until 

Non-Smoking Policies in Public Housing - This notice is 
a reissuance of PIH Notice 2009-21 which strongly 

http://portal.hud.gov/huddoc/pih2012-35.pdf
http://portal.hud.gov/huddoc/pih2012-34.pdf
http://portal.hud.gov/huddoc/pih2012-33.pdf
http://portal.hud.gov/huddoc/pih2012-32.pdf
http://portal.hud.gov/huddoc/attach32.pdf
http://portal.hud.gov/huddoc/pih2012-31.pdf
http://portal.hud.gov/huddoc/pih2012-30.pdf
http://portal.hud.gov/huddoc/pih2012-29.pdf
http://portal.hud.gov/huddoc/pih2012-28.pdf
http://portal.hud.gov/huddoc/pih2012-27.pdf
http://portal.hud.gov/huddoc/pih2012-27att-a.pdf
http://portal.hud.gov/huddoc/pih2012-27att-b1.pdf
http://portal.hud.gov/huddoc/pih2012-27att-b2.pdf
http://portal.hud.gov/huddoc/pih2012-26.pdf
http://portal.hud.gov/huddoc/pih2012-25.pdf
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amended, superseded, or 

rescinded 

encourages Public Housing Authorities (PHAs) to 

implement smoke-free policies in some or all of their 
public housing units. 

PIH 2012-24 Issued: May 22, 2012 

Expires: Effective until 

amended, superseded, or 
rescinded 

Rent to Owners in subsidized projects under the Housing 

Choice Voucher (HCV) program - The purpose of this Notice is 

to provide guidance to Public Housing Authorities (PHAs) when 
determining the rent to owner for an HCV tenancy when the 
participant family chooses to lease a unit under the HCV 
program. [...] 

 

http://portal.hud.gov/huddoc/pih2012-24.pdf

